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User Interface Map

The map below shows some of the main functions you will use the most.

The layout of the data fields and their labels might differ from your copy, but all the 
functions shown are the same.
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Installation (setup program)

If you have not already done so, download the setup program from the 
following address.

http://primesales.net/ALLDEX/DownloadNow.html

Then click on the appropriate “setup program” download link.

You should be presented with a window similar to this.  Save the file to 
somewhere you are familiar with, such as “My Documents” or your 
“desktop”.

After you have saved the setup program to your computer, run it by 
double-clicking on it's icon.

The installation program will install AllDex on your computer.

http://primesales.net/ALLDEX/DownloadNow.html
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Windows Vista – and running as Admin
(Running the program vs. running as admin)

The following may or may not pertain to your situation.

If you are running Windows Vista, or any other version of windows that 
allows you to run programs as administrator, then you may want to 
consider running the program as administrator, and here's why...

The folks at Microsoft – and their desire to protect us from ourselves 
have really fouled things up a bit (in our opinion anyway).

If you need to know exactly where your data is being saved to, 
because you might move the database to a shared folder on a server 
or copy it to another location  for example, then please read this 
section carefully.

In our experience (at least with Windows Vista), if you simply double-
click on the AllDex program icon to run it, and you create or edit 
records – saving them to the database, the changes you make to the 
database probably won't be made to the database location you expect. 
For example, I would expect the changes to be made to the database 
where I know the database is located, which should be something like 
“C:\Program Files\AllDexContacts\AllDexContacts.mdb”, but what the 
folks at Microsoft have done – in order to protect us from ourselves, is 
cause the data to be saved to a hidden “copy” of the database that is 
now hidden in some impossible obscure location on your computer. 
Apparently, they have done this to protect you from yourself.

So what's the big deal? You ask.  Well, the big deal is if you open the 
AllDex program by double-clicking on its icon, any changes you make 
to the database are not necessarily going to show up if you later run 
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the program as Administrator.  The bottom line is there would be two 
copies of the same database, one in the program files folder, and one 
in some hidden obscure folder that we are not suppose to know about. 
These two copies of databases are never “in-sync”.

So, however you decide to open the AllDex program, just be 
consistent, because there is a big difference between simply running 
the program versus running the program as administrator.

If you are using AllDex in a corporate environment, check with your 
computer management people to see how you should be running 
AllDex.

To run AllDex as administrator guarantees that the data you save will 
in fact be saved to the database in the program files folder (or 
whichever location the Database Manager in AllDex shows you are 
connected to).

To run AllDex as administrator, Right-Click over the program icon 
and select “Run as administrator” as shown below.

Or, if you choose not to run as administrator, just select open or 
double-click the icon as usual.
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Registration (removes 20 record limitation)

Registering the program is required to remove the 20-record limitation. 
Once registered, you can create an unlimited number of records.  The 
registration process consists of the following...

Step 1:  Purchase a license and submit the program serial number.
Step 2:  Enter the registration code from an email that we send you.

To begin the registration process, click ''File'' then click ''Register 
This Software''.
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You are then presented with the Registration window as shown below.

Make note of the serial number that your program generates (similar 
to the one shown below).  Note: The serial number will be different for 
every computer.  Then click the link to go to our website's registration 
page.

Note:  Your license is good for up to 10 registration keys, so if 
you later get a new computer and need to register the program 
on a new computer, or you are setting up a network of multiple 
computers, you can obtain additional registration keys for FREE. 
You will need a different registration key for each computer.  Just 
click the link titled “I need another Registration Key”.
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You are then presented with the Registration form on our website.

Enter the serial number and click the “Buy Now” button.  The 
transaction is completed on Paypal.com as shown below.
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Once you complete the transaction on Payal.com, we will 
generate a Registration Key and email it to you within 24-hours.

After you receive the Registration Key, open the AllDex program and 
pull up the Registration window again by Clicking “File”, then click 
“Register This Software”, and click on Step 2: Enter Registration Key.

After you enter a valid Registration Key and click the Save 
Registration button, the program is then fully registered and you can 
now create as many records as you want.
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Creating, Editing and Saving Records

To create a new record, simply click the “Add New” record button. 
This action will instantly create a new blank record.  Type in the data 
you want, and click the “Update” button as shown in the graphic below.

Note:  It is a good idea to type in as many relevant key-words 
associated with the record you are creating.  Doing so will help 
make searching for the record much more robust.

To Delete a record, click the X-delete button.  The program will give 
you a chance to cancel the delete action or confirm your decision to 
delete the record before proceeding.



11

Searching for Records

To search for a record, simply type in the search word in the Search 
box and hit Enter on your keyboard.  All records containing your 
search will appear in the record list on the left.  Just click on the record 
in the list to view it.  You can select which fields you want to search by 
making your selection in the drop-down box, or you can select All-
Fields if you want to perform a full wide search of the database.

Once you are viewing the record you want, you can also search for a 
word within the record you are viewing.  Just type in a search word in 
the Highlight box and click the button to the right.  All occurrences of 
the word will be highlighted in red.

NOTE:  You can click the Refresh button at the top of the window to 
refresh and show all the records in the database.
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Assigning a Password to View a Record
(making a record private)

In some cases, you might find a need to make a record private – to be 
viewed only by you after entering a password.

To assign a password to a record, start by clicking on “File” then 
click “Change Record Password”.  You will then be presented with an 
input box to enter a password for the current record you are viewing, 
like the one shown below.  The program will ask you to enter the 
password twice to confirm.  Once the password is accepted, anytime 
the record is attempted to be viewed, it will be blocked and a 
password prompt will appear.  If the correct password is entered, the 
record is temporarily un-blocked for the user with the password.

To remove a password from a record, you will first be asked to enter 
the existing password, then you can either change it or clear it.  Click 
“Cancel” to clear the password.
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The Database Manager

The Database Manager can be found when you click on “Database” at 
the top of the main window.  The Database Manager basically allows 
you to connect to a database.

If you were to copy the database and paste it into a shared drive or 
shared folder on a network for example, you could then use the 
Database Manager to navigate to the database and connect to it.  So 
if you have several users wanting to run the AllDex program from their 
respective computers on a network, all of them can access the same 
database by using the Database Manager.
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Import / Export

The AllDex program comes with an Import and an Export feature.

These features can be found by clicking on “Database” at the top of 
the main window, and selecting “Import” or “Export”.

The import feature will allow you to import comma delimited data. 
Since most database programs allow you to export the records you 
may have from an old program, you should be able to export the old 
records to a comma delimited text file, and then use the import feature 
of AllDex to import those records into the AllDex database.

The import feature allows you to make changes to the data you are 
importing because it will first import records into a large text box area, 
which allows you to make any changes to the data if necessary, and 
then the actual importing process will import the records from the text 
box area and import them into your current database.

The import feature has a clear 3-step process and all you have to do is 
follow it.

After you have imported records into an AllDex database, the data 
may not “line-up” with the labels.  For example, you don't want to have 
a label that says “Company Name:” but the data is a phone number. 
The easiest solution for this situation is to use the “Design” menu to 
change the label names.  Click the “Design” menu located at the top of 
the main window.  This is covered more in the next section.
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Design

(Change the Color Scheme)

You can change the color scheme at anytime.  Start by clicking on 
“Design” at the top of the main window.  Select “Change Color 
Scheme” and use the color scheme window to experiment and make 
changes to the color scheme of the header background, the font 
colors, and the window background.
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Design

(Change the Labels)

You can change the label names and their docking position to their 
associated text-box.  Start by clicking on “Design” at the top of the 
main window and selecting “Change the Labels”.  The wizard shown 
below is straight forward and easy to follow.
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Backing Up Your Data

You can backup your data with the “Application Backup” program that 
comes with AllDex.

To start the Backup process, click on the “File” menu then select 
“Backup Data”.  The AllDex program will close and the Application 
Backup program will open.

If the Application Backup program did not automatically select the 
correct path, you can navigate to the correct path where all the files 
are located.  In most cases, the path should be something like...
“C:\Program Files\AllDexContacts\”
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Case Study
(a busy parts department)

“I use AllDex-Contacts to help manage my 
key customers”.

- Ed Kuchynka, Parts Manager
Norlift, Inc.

“I use AllDex-Contacts to help manage my 
key parts vendors”.

- Dean Gay, Parts Counterman
Norlift, Inc.

“I use AllDex-Contacts for EVERYTHING, from customers and vendors – to managing factory  
parts returns - to looking up parts that are hard to find in the OEM issued parts look-up 

software we use”.  I even use it at home!
- Chris Eckersley, Parts Counterman,   Norlift, Inc.
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AllDex has proven itself to be a very valuable tool.

Norlift, Inc – a material handling company located in Spokane, 
Washington has been using AllDex-Contacts in the parts department 
for several years.  The program is used for all kinds of purposes, so 
it's not just used as a contact management system.  It's true that it is 
being used as a contact management system for both customers and 
vendors, but it is also being used for looking up all kinds of forklift 
related parts and lots of other helpful information necessary in the 
regular course of daily business activities of a busy parts department.

For example, because of the large memo-field in AllDex, a lot of data 
can simply be copied from a source and pasted into the AllDex 
program, thereby making that information now accessible to the entire 
parts department team, and making the information searchable.

Here are just a few of the things that the Norlift parts department 
uses the AllDex program for, and it saves a massive amount of 
time...

Customers, vendors, hard-to-find parts, forklift tires and tubes, 
propane tanks, propane conversion kits, paints chemicals and fluids, 
engine information, fork sizes and specifications, lift-chain sizes and 
specifications, hydraulic hose types and fittings, battery group sizes 
and specs, battery cables, electrical components and diodes, 
distributor cap styles and tune-up parts, OEM parts reference 
numbers, labor rates, tax rates, important emails and technical 
bulletins, links to files on the company server, website log-in 
credentials, special math formulas and conversion charts, phone 
menu short-cuts, hazardous shipping instructions, MSDS, shipping 
company's and discounts, parts bulletins, seats and seat cushion 
sizes, seat belts, vendor minimum orders and discounts, new products 
introduced, keeping a customer's “wish list”, warranty procedures and 
coverages, mechanics cell phones, hydraulic oil types, company name 
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changes, internal account numbers and coding procedures, special 
billing procedures - - - and the list could go on indefinitely...

At Norlift, AllDex-Contacts is really being used for what it was truly 
designed for.  A software program that allows all the users to share 
and access data that you would not normally find easily by other 
means.  The value of the program increases with every bit of 
information that is entered by other AllDex users on the company 
network  – collectively making the AllDex-Contacts program a hub of 
information sharing.

This tool ultimately saves untold amounts of time and effort and allows 
the users to focus on the primary objectives of their job.

The bottom line...

This time saving tool actually makes the company money just by 
keeping everyone working efficiently.


